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What Is GIS?
Making decisions based on geography is basic to human thinking. Where shall we go, what will it be 
like, and what shall we do when we get there are applied to the simple event of going to the store or 
to the major event of launching a bathysphere into the ocean's depths. By understanding geography 
and people's relationship to location, we can make informed decisions about the way we live on our 
planet. A geographic information system (GIS) is a technological tool for comprehending geography 
and making intelligent decisions.

GIS organizes geographic data so that a person reading a map can select data necessary for a 
specifi c project or task. A thematic map has a table of contents that allows the reader to add layers 
of information to a basemap of real-world locations. For example, a social analyst might use the 
basemap of Eugene, Oregon, and select datasets from the U.S. Census Bureau to add data layers 
to a map that shows residents' education levels, ages, and employment status. With an ability to 
combine a variety of datasets in an infi nite number of ways, GIS is a useful tool for nearly every fi eld 
of knowledge from archaeology to zoology.

A good GIS program is able to process geographic data from a variety of sources and integrate 
it into a map project. Many countries have an abundance of geographic data for analysis, and 
governments often make GIS datasets publicly available. Map fi le databases often come included 
with GIS packages; others can be obtained from both commercial vendors and government 
agencies. Some data is gathered in the fi eld by global positioning units that attach a location 
coordinate (latitude and longitude) to a feature such as a pump station.

GIS maps are interactive. On the computer screen, map users can scan a GIS map in any 
direction, zoom in or out, and change the nature of the information contained in the map. They can 
choose whether to see the roads, how many roads to see, and how roads should be depicted. Then 
they can select what other items they wish to view alongside these roads such as storm drains, 
gas lines, rare plants, or hospitals. Some GIS programs are designed to perform sophisticated 
calculations for tracking storms or predicting erosion patterns. GIS applications can be embedded 
into common activities such as verifying an address.

From routinely performing work-related tasks to scientifi cally exploring the complexities of our world, 
GIS gives people the geographic advantage to become more productive, more aware, and more 
responsive citizens of planet Earth.
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Modeling GPS Data
Captured on the Fly

By Mike Price and Amy Fox, Entrada/San Juan, Inc.

This tutorial replicates part of the Los Angeles Fire Department (LAFD) Air Operations (Air Ops) 
data processing workfl ow. It demonstrates how to use rapidly calculated longitude and latitude 
values for fl ight path points, convert selected points into a closed polygon, and calculate perimeter 
and area for a selected fl ight polygon using ArcGIS 9.1 and a third-party ArcGIS extension, 
XTools Pro. For background information on the development of this workfl ow, see the 
accompanying article, "Tragedy to Triumph."

This tutorial creates 
the point fl ight path 
and derives an incident 
polygon from data 
collected during a 
training fl ight by LAFD
Air Ops.

What You Will Need
•  ArcGIS 9.x (ArcView, ArcEditor, or ArcInfo
 license level)
•  Evaluation copy of XTools Pro downloaded
 from www.xtoolspro.com/download
•  Sample dataset from ArcUser Online
•  WinZip or other similar zipping utility
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Visit ArcUser Online (www.esri.com/arcuser) and download the zipped archive containing the data 
for this exercise. Unzip the archive and open ArcCatalog to view the fi les. The archive creates a 
parent directory named FireMap that contains two subdirectories, one for shapefi les and one for 
grid fi les. The grid fi les are registered in California State Plane North American Datum of 1983 
(NAD83) Zone V U.S. Feet. Most shapefi les are registered in California State Plane with the 
exception of the training data fi le TR1_060316_1122 that was created in the World Geodetic 
System 1984 (WGS84) geographic coordinate system.

Next, visit Data East's download portal at www.xtoolspro.com/download and obtain a 30-day 
evaluation copy of the XTools Pro extension. Table 1 summarizes XTools Pro features and 
functions. Many basic functions are available in the free download while additional functionality can 
be purchased online. This tutorial uses these three free functions:

Add XYZ Coordinates 

Make One Polygon from Points 

Calculate Area, Perimeter, Length, Acres and Hectares 

After downloading and extracting the XTools Pro archive, navigate to the directory containing the 
XTools Pro 3.2.0 folder and double-click the setup.exe fi le. After working through the setup wizard, 
verify the program has been installed by navigating to \ProgramFiles\DataEast\XToolsPro3. Restart 
ArcMap. Enable the XTools Pro extension by choosing Tools > Extensions from the Standard menu 
and checking the box next to the XTools Pro extension. Close the Extensions dialog box. In the 
Standard menu, choose View > Toolbars and add the XTools Pro toolbar.

Getting Started
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Add the shapefi les and hillshade to create a basemap for the training data.

1. Start ArcMap and open a new map document. 

Navigate to FireMap\SHPFiles\CASP835F\ and add the Project Boundary LYR fi le to the Data 2. 
Frame. If the data connection in the layer fi le is broken, right-click Project Boundary's name 
in the table of contents (TOC), choose Data > Set Data Source, and navigate to FireMap\
SHPFiles\CASP835F\Clippol1.

Building a Basemap
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Open the Data Frame properties and verify that the Project Boundary data has set the 3. 
coordinate system to CA State Plane NAD83 Zone V US Feet. Click the General tab and 
rename the Data Frame CA State Plane NAD83 Zone V US Feet.

Load the remaining layer fi les stored in the FireMap\SHPFiles\CASP835F folder. Each LYR fi le 4. 
should load the appropriate shapefi le or grid and associate it with the desired thematic legends. 
Repair any broken links by right-clicking on the layer fi le in the TOC, selecting
Data > Set Data Source, navigating to FireMap\SHPFiles\CASP835F\, and selecting the 
shapefi le corresponding to the layer fi le. 

Add the Topo Hillshade layer stored in FireMap\GRDFiles\CASP835F and arrange the TOC 5. 
data layers in the following order (top to bottom):

Fire Stations1. 

Hospitals2. 

LAFD Helispots3. 

TIGER Transportation4. 

Municipal Boundary5. 

Project Boundary6. 

Evacuation Sites7. 

TIGER Hydrography8. 

Topo Hillshade (transparency set to 50 percent)9. 

Wildland Urban Interface (no forward slash between Wildland and Urban!)10. 

LAFD Battalions (labeled)11. 

Save the map in the FireMap folder and name it FireMap1. Become familiar with the data layers 6. 
and check out the attributes for each.
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With the basemap created, the GPS data can be added to the map document. This data was 
gathered during a training fl ight in northern Los Angeles County on March 16, 2006. Navigate to 
FireMap\SHPFiles\LatLon84 and load TR1_060316_1122, a single point shapefi le. Its name, TR1_
060316_1122, indicates that it was collected during a training fl ight by Airship 1 on March 16, 
beginning at 1122 (i.e., 11:22 a.m. Pacifi c standard time). An ArcMap dialog box will warn that the 
data was created in another projection and will be transformed to California State Plane. Inspect 
this data and its attribute table. The fl ight began at Air Ops headquarters at the Van Nuys Airport, 
then traveled east over the San Gabriel foothills.

XTools Pro will be used to calculate the X- and Y-coordinates for the fl ight paths. In the TOC, right-
click the TR1_060316_1122 point layer and choose Open Attribute Table. Notice that the Lat and 
Lon fi elds contain zero values. These fi elds will be updated with coordinates in decimal degrees 
WGS84.

Click the XTools Pro toolbar 1. 
drop-down arrow and select 
Table Operations. Select Add 
X,Y Coordinates. In the Add 
X,Y,Z Coordinates dialog box, 
hold down the Shift key and 
highlight the TR1 set. Check 
the Add X Coordinate box and 
change the fi eld name to Lon. 
Check the Add Y Coordinate 
box and change the fi eld 
name to Lat. Uncheck the Z 
Coordinate box and leave 
the point drop-down boxes 
(e.g., Multipoint, Polyline, 
and Polygon) with the default 
value.

Click Specify. A new spatial 2. 
reference box will appear. 
Click Select and double-click Geographic Coordinate Systems. In the World folder, select the 
WGS 1984.prj defi nition. After selecting this coordinate system, click Add, then click OK.

Loading Flight
Path Data

Calculating Longitude 
and Latitude Values 

for Flight Points
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In the Add X,Y,Z Coordinates box, click OK. Click Yes to overwrite existing Lon and Lat fi elds 3. 
in the attribute tables. Verify that each attribute table has a new set of latitude and longitude 
coordinates. Notice that the decimal precision carries six characters to the right of the decimal. 
At this latitude, this represents precision of less than one meter. Save the project.

After calculating the X- and Y-values, notice that the decimal precision carries six characters
to the right of the decimal. At this latitude, this represents precision of less than one meter.

Zoom into the map just north of where the fl ight path crosses above Fire Station 87 so that the map 
scale is 1:5,000. Select 17 points north of the station that represent one-half mile of fl ight line. 
Looking at this data, how fast was the helicopter fl ying? (Hint: Measure the distance between point 
0 and point 16. Each point represents one second of air time. Traveling one-half mile in 16 seconds 
represents a ground speed of 112.5 mph, or slightly less than two miles per minute.)

Reset the map scale to 1:12,000 and pan north along the fl ight points to the loop in the fl ight path 
(i.e., where the fl ight path crosses itself). It traces the perimeter of an area of interest. The UltiChart 
navigation unit in the helicopter accurately captured this boundary. Using the Select Features tool, 

Measuring Flight 
Paths and Calculating

Ground Speed

Retracing the
Flight Path
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capture the two points just outside the closed loop. Open the Attribute Table and click Show: 
Selected Records to display only those features (FID points 344 and 476). Confi rm that the airship 
required just over two minutes to fl y this perimeter. Did you notice that the helicopter was fl ying in a 
counterclockwise direction? Because the pilot sits in the right seat, this perimeter path was guided 
by the navigator in the left seat.

The fl ight loop shows an area of interest. Using the Select Features tool, capture the two points just outside
of the closed loop. Open the attribute table and click on Show: Selected Records

to display only those features (FID points 344 and 476).
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Boolean logic can be used to defi ne the polygon area of the fl ight path by selecting the points that 
initialize the loop and writing a query to limit the shape of the fl ight path to these points. Can you 
determine where the loop originates and ends? Note the lowest and highest FID numbers of the two 
points inside the loop are 345 and 475.

In the Attribute Table, click the Options drop-1. 
down arrow and choose Select by Attributes.

In the Select by Attributes dialog box, write this 2. 
query:  "FID" >=345 AND "FID" <=475. Click 
Apply and close the Select by Attributes dialog 
box. Close the Attribute Table. This selects 131 
points that are arranged in a ghostlike loop.

A polygon can be created from this poly/point 3. 
selection. Verify that TR1_060316_1122 is the 
active layer in the TOC. Click the XTools Pro 
drop-down arrow on the XTools Pro toolbar and 
select Feature Conversion. Choose Make One 
Polygon from Points.

In the Output storage window, click the browse 4. 
button and navigate to the SHPFiles\LatLon 
directory. In the Name New Feature Class 
box, highlight TR1_060316_1122 by clicking 
one time. Edit the source name by adding an 
underscore and the suffi x P1 (_P1). The point 
layer TR1_060316_1122 becomes a polygon 
named TR1_060316_1122_P1. Click Save and 
OK. ArcMap adds the new polygon layer to 
the top of your table of contents, and it will be 
given a default color. Select a bright color for 
the polygon. Turn off the original TR1 layer by unchecking the box. Clear all selected features; 
choose Selection > Clear Selected Features. Save the project.

Creating a Closed 
Polygon from Points 

with XTools Pro

Choose the Select by Attributes dialog box, and use a query to 
select all the points in the loop.
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1. Right-click TR1_060316_1122_P1 and choose Zoom to Layer. Open this layer's attribute table. 
Move the table in the lower left part of the display.

Click the XTools Pro drop-down arrow on the XTools toolbar. Choose Select Table Operations > 2. 
Calculate Area, Perimeter, Length, Acres and Hectares. In the Calculate window, locate Output 
Projection and click Specify.

Click the XTools Pro drop-down arrow on the XTools toolbar and choose Select Table
Operations > Calculate Area, Perimeter, Length, Acres and Hectares.

Calculating Perimeter 
and Area
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Click the Specify button in the Spatial Reference Properties dialog box and choose Projected 3. 
Coordinate Systems. Navigate to State Plane, then NAD 83 (Feet), and select NAD 83 
StatePlane California V FIPS 0405 (Feet).prj. Click Add, OK, and OK. Change desired output 
units to Feet. This is a critical and easy to miss step! Accept all other default selections and 
click OK. The attributes now include measurements. Minimize the Attribute Table and save the 
project.

A polygon can be created from this poly point selection.

When using the Calculate Area, Perimeter, Length, Acres
and Hectares function in XTools Pro, be sure to change

the input units to feet.

1. Use the Identify tool to verify that the new polygon has an area of 179.147730 acres. To create 
a label, right-click TR1_060316_1122_P1 and select Properties. Choose the Labels tab and 
click the Expressions button. In the Expressions box, type: "Flight Polygon" & [ID]+1& 
VBNewLine & ROUND([Acres],2) & " Acres"  Be certain to insert a leading space before the text 
" Acres". Click Verify to confi rm the expression and label format. Click OK twice to exit both 
dialog boxes.

Validating and 
Labeling the Polygon
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Use an expression to label the new polygon.

In the Layer Properties dialog box, click Symbol. In the Symbol Selector dialog box, click 2. 
Properties. Click the Mask tab and set the Halo to 2.00 points. Click OK. In the Symbol Selector 
dialog box, choose Arial font at 18 points, bold, italic. Click OK.
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In the Layer Properties dialog box, check Label features in this layer. Click OK and apply the 3. 
new label properties to the map. Verify that the label was successfully created.

The fi nished fl ight polygon is labeled with the area of the polygon.

This tutorial creates the point fl ight path and derives an incident polygon from data collected during 
a training fl ight by LAFD Air Ops. LAFD's mapping program is growing rapidly. Steven Robinson, the 
program's creator, envisions the day when a captured polygon, merged with current demographic 
information, will be transferred to incident managers in real time. When processed by reverse 911, 

Summary
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citizens at risk may be quickly alerted. Through careful program design, staff training, current data 
development, and support from LAFD management and technology providers, Robinson's dream is 
within reach.

This tutorial replicates part of the Los Angeles Fire Department (LAFD) Air Operations (Air Ops) data processing
workfl ow. Rapidly calculated longitude and latitude values for fl ight path points are converted into a

closed polygon and the perimeter and area calculated.
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Tragedy to Triumph
Pilot's Vision Leads to Onboard State-of-the-Art Mapping

In March 1998, three Los Angeles city fi refi ghters 
and a young girl being transported to a hospital 
were killed in a helicopter crash in the Griffi th Park 
area of Los Angeles, California.

Steven Robinson, the helicopter's pilot, was one of 
two crew members who survived the crash. Despite 
several years of rehabilitation, Robinson was 
unable to return to active fl ight status. However, 
instead of leaving the Air Operations (Air Ops) 
service, Robinson developed and implemented 
a state-of-the-art data capture, analysis, and 
mapping program that provides the Los Angeles 
Fire Department (LAFD) airships with high-quality 
current maps onboard and a current common 

operating picture (COP) to emergency managers and responders for a wide range of emergency 
and nonemergency events.

When Robinson discovered that the GPS-based onboard navigation system for the department's 
helicopter fl eet accurately captured an airship's position during every second of fl ight, he envisioned 
a process for carefully tracing and recording the perimeter of emergencies and other events such as 
wildland fi res, hazmat accidents, natural disasters, and public gatherings.

In 2002, Robinson approached ESRI to request assistance with mapping technology, data 
development, and real-time mapping. Russ Johnson, ESRI's public safety solutions manager, 
recognized the value of Robinson's idea. With technical assistance from ESRI and hardware 
donated by Hewlett-Packard, Robinson's helicopter mapping program literally took off.  As the 
program has grown, it has been recognized by the City of Los Angeles, neighboring communities, 
and adjoining counties. Robinson received many more requests for mapping services than he could 
handle. He decided to develop and support a standard data capture workfl ow, template-based 
incident mapping, and a training program that would empower helicopter pilots, fl ight medics, and 
fi refi ghters to participate in aerial data collection and emergency mapping.
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LAFD Air Ops began using an ArcGIS extension called XTools Pro to quickly and easily manage 
and model fl ight path points. Originally developed in the mid-1990s by the Oregon Department of 
Forestry, XTools for ArcView 3.x gained broad acceptance among wildland fi re mappers and natural 
resources GIS professionals. After the release of ArcGIS 8, XTools was acquired by Data East, 
LLC, an authorized business partner of ESRI Russia's distributor Data+. Data East ported XTools to 
ArcGIS 9 and sells XTools Pro 3.2 through its Web site at www.xtoolspro.com.

In early 2006, ESRI sponsored a program to defi ne a standard workfl ow and train Air Ops mapping 
staff. Project requirements included capturing high-quality GPS points and rapidly transferring these 
points to a modeling computer. First, the GPS points are managed and fi ltered to map fl ight paths 
and incident boundaries. Next, the points are converted to polygons and perimeters and those 
areas are calculated. The map elements are then posted in a standard map template for plotting 
and delivery to incident managers.
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Got It Covered
Modeling Standard of Cover with ArcGIS
Network Analyst 9.2

By Mike Price, Entrada/San Juan, Inc.

Throughout much of the United States, the Insurance Services Offi ce (ISO) maps fi re station 
locations and measures response capabilities based on transportation systems, equipment, 
personnel, and other factors. It assesses and reports on the level of protection provided to member 
insurers. 

The following exercise uses the new ArcGIS Network Analyst 9.2 extension to map and model time- 
and distance-based response around existing and proposed fi re stations throughout King County 
Fire District 37. The exercise maps 1.5 mile ISO fi re hydrant deployment, fi ve-minute distribution, 
eight-minute concentration, and optimal time-based response for all stations.

ArcGIS 9.2 and the new Network Analyst extension provide many enhancements and 
improvements for public safety modelers. Geometric calculations within attribute tables are easier to 
perform. The new Network Dataset accommodates complex turn rules and multimodal travel. The 
service area polygon solver incorporates buffered trimming around outlying paths. A new optimal 
solver creates coincident polygons using time or distance to help defi ne station service areas. This 
exercise introduces these enhanced features. For more information, see accompanying article, 
"Developing a Standard of Cover."

Visit the ArcUser Online Web site at www.esri.com/arcuser and download the sample dataset for 
this tutorial. 

Unzip the archived sample dataset at or near the root directory of a local drive. The archive 1. 
creates a folder called FD37 with a SHPFiles folder, containing a subfolder called WASP83NF. 

Starting the Exercise

What You Will Need
•  ArcGIS 9.2 (ArcInfo, ArcEditor, or ArcView license)
•  ArcGIS Network Analyst 9.2 extension
•  Sample dataset downloaded from ArcUser Online
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Open ArcCatalog and explore the sample data in WASP83NF. It consists of six shapefi les and 2. 
six associated layer fi les. Link the Layer fi les to the source shapefi les by right-clicking on each 
one in the table of contents, accessing the Properties dialog box, selecting Data > Set Data 
Source, and choosing the shapefi le referenced by the Layer fi le.

After loading the data in a new ArcMap document, arrange the data layers as shown here.
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Examine these fi les using both Geography and Tables view and look at the metadata. Note 3. 
that this data is in the Washington State Plane North Zone coordinate system using the North 
American Datum for 1983 (NAD 83) and U.S. Survey Feet as units of measure.

Carefully preview the streets_nw data table. It includes fi elds for length in both feet and 4. 
miles and a fi eld recording travel time in minutes. These fi elds contain zero values but will be 
populated later using the Field Calculator. Notice that the OneWay and MPH fi elds contain 
important Network Analyst travel restriction and impedance values.

Start ArcMap and create a new map document. Load all the Layer fi les except the 10 Minute 5. 
Optimum Polygons. All data layers share the same coordinate system (i.e., Washington State 
Plane North Zone), and each fi le contains proper projection metadata so the incoming layer 
fi les set the coordinate system for the Data Frame. Arrange layers in the following order (from 
top to bottom):

Fire Hydrants

Fire Stations

Network Streets

Kent City Limit

King County Fire District 37

Clipping Polygon

Save the map as FD37_1.mxd. Open the Network Streets table to calculate lengths and 6. 
impedance values for three important fi elds.



NOVEMBER 2009  FIRE MAPPING22

Preview the sample data in ArcCatalog.

ArcGIS 9.2 contains an important new toolset to calculate data geometry directly within a table. 

Open the Network Streets attribute table and verify that no records are selected. Locate the 1. 
Length_Ft fi eld and right-click on the fi eld name. Notice a new choice on the context menu 
called Calculate Geometry. Click on it.

New ArcGIS 9.2 Tools 
for Calculating Fields
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In the Calculate Geometry dialog box, choose Length and Feet US. It will use the coordinate 2. 
system of the Data Frame. Click OK.

Calculate the polyline properties using the Calculate Geometry dialog box.

Use Field Calculator to convert segment lengths from U.S. feet to miles. Right-click on the 3. 
Length_Mi fi eld and choose Field Calculator. In the Field Calculator, use the expression 
[LENGTH_FT]/5280 to divide the length in feet by the length of a mile. Inspect the values 
generated by sorting them in ascending order. Notice that the precision setting precludes a 
record with a length of zero miles.Finally, calculate the travel time for each segment in minutes. 
Through fi eld testing, King County Fire District 37 has determined that it is appropriate to assign 
a travel time for all segments at 80 percent of posted speed limit for streets in the district. To 
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calculate this value for all segments, right-click on the Minutes fi eld, select the Field Calculator, 
and type the following equation in the formula box: [LENGTH_MI] *(60/([MPH]*0.80)).

Click OK to perform the calculation for all 14,115 records. Manually calculate the value for a few 4. 
records to check the output. Save the map again and close ArcMap.

The network dataset is built in ArcCatalog. This exercise uses a simplifi ed version of the city of Kent 
street network that has been tuned to run quickly and consistently for this project. Two 
impedances—one for distance and one for time—will be created, and one-way travel on the 
freeways will be respected.

Reopen ArcCatalog and choose Tools > Extensions, and verify that the Network Analyst 1. 
extension is available.

Navigate to the streets_nw shapefi le. Right-click on it and select New Network Dataset. Accept 2. 
the default name streets_nw_ND and click Next to continue. Click the Connectivity button to 
verify that simple End Point rules will be used in creating this network dataset. Click OK and 
click Next.

The street network already includes freeway crossings so there is no need to modify the 3. 
elevation connectivity fi eld. Click the radio button next to No. Click Next again.

Click the radio button next to Yes to model Global turns. Click Next.4. 

Notice that Minutes and Oneway are both reserved Network Analyst fi eld names. Because 5. 
these names match appropriate fi elds on the network dataset, Network Analyst identifi es 
these fi elds and sets them up for the network. Specify one additional impedance attribute fi eld. 
Manually add Length_Mi, the distance fi eld, by clicking Add and typing Length_Mi in the Name 
box. Leave Usage Type as Cost, change Units to Miles, and leave Data Type as Double. Click 
OK. Click Next again.

Leave the driving directions as Yes, the default choice. Click Next.6. 

Creating a Network 
Dataset
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The next pane lists network dataset parameters. Check that they match the parameters listed in 7. 
Table 1. Before clicking Finish, select the listed parameters, copy them to the system clipboard, 
and paste them into a WordPad document. Save this fi le with the network data for future 
reference.

New Network Dataset Parameters Action

Name streets_nw_ND Click Next

Connectivity streets_nw End Point Click OK,  Click Next

Elevation Data Field No Click Next

Model Turns Yes, Global Turns Checked Click Next

Network Attributes

(Default) Minutes, Cost, Minutes, Double 

Click Next(Default) Oneway, Restriction, Unknown, 
Boolean

(Add) Length_Mi, Cost, Miles, Double

Driving Directions Yes Next

List of dataset parameters (Lists parameters set) Check, Copy to Wordpad, Click 
Finish

Table 1: Set new network dataset parameters in ArcCatalog

Click Finish to create the new network dataset. Click Yes to build the dataset. The new network 8. 
dataset consists of a street feature class named streets_nw_ND and a point feature class 
named Streets_nw_ND_Junctions. Inspect these fi les and close ArcCatalog. 
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Reopen ArcMap and reopen FD37_1.mxd to 
begin creating four Service Areas. One Service 
Area will be based on distance and the other 
three on time. Each Service Area will provide 
more information about the level of service
(i.e., the standard of cover or SOC) provided by 
Fire District 37. 

King County Fire District 37 presently staffs 
seven fi re stations located in and near the 
city of Kent, Washington. As growth extends 
to the southeast and the west, Fire District 37 
wishes to provide a higher level of service in 
rural areas. Sites have been identifi ed for two 
additional stations east of the incorporated 
city and one new station in the western area 
of the core community. With Network Analyst, 
travel footprints can be created for both existing and proposed stations and modeled to show best 
alternatives for deployment of equipment and personnel. 

Study the fi re stations carefully. The existing stations are numbered 71 through 77 and the proposed 
stations, 78, 79, and the Washington Avenue station, a large station with a full fi refi ghting force and 
chief, engine, and ladder. The attributes table for the Fire Stations layer lists the apparatus
(i.e., fi refi ghting equipment) and personnel planned for these proposed sites.

Using the Tools > Extensions selection on the text menu, verify that the Network Analyst 1. 
extension is available, and open the Network Analyst toolbar. Explore the drop-down menu and 
hover the mouse cursor over the tool buttons to read the Tool Tips. 

Add Streets_nw_ND to the map and make sure it is the active network dataset. In the Network 2. 
Analyst toolbar, click the Show/Hide Network Analyst window button to make this window 
visible.

Building a 1.5-Mile 
Service Area

Facilities Parameters

Load From: Fire Stations

Sort Field: None

Location Analysis Properties
Curb Approach Either side of vehicle

Attr_Minutes 0

Name LABEL

Attr_Length_Mi 0

Breaks_Minutes Blank

Breaks_Length_Mi Blank

Location Position
Use Geometry 500 Feet

Table 2: Loading parameters for fi re station facilities
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Click the Network Analyst drop-down menu 3. 
and select New Service Area. The Network 
Analyst window (located to the right of the 
table of contents) now references the new 
Service Area and lists four possible network 
data types: Facilities, Barriers, Polygons, and 
Lines.

Right-click on Facilities and select Load 4. 
Locations. Select Fire Stations as the Facilities 
layer and fi ll out all fi elds as listed in Table 
2. Be especially careful to select the LABEL 
fi eld as the Name property. A 500-foot search 
tolerance limits station locations to within 
one block of existing streets. This should be 
suffi cient for locating new and current stations. 
Click OK to accept these parameters and load 
the fi re stations. Verify that 10 stations are 
shown (including the proposed station on North 
Washington Avenue).

Right-click Service Area in the table of 5. 
contents, choose Properties, click the General 
tab, and change the name to 1.5 Mile ISO 
Service Area. Click on the other seven tabs in 
this dialog box and change the setting for each 
as shown in Table 3a. After completing all tabs, 
save the map document, click OK, and create 
the fi rst Service Area by clicking the Solve 
button on the Network Analyst toolbar or by 
right-clicking on the SA name in the TOC and 
selecting Solve. This operation could require 
several minutes to complete.

The fi rst SA models 1.5-mile travel away from 
all fi re stations. By trimming all polygons to 

1.5 Mile Service Area Wizard Settings

Analysis Settings Tab
Impedence Length_Mi
Default Breaks 1.5
Direction Away From Facility
Allow U-Turns Everywhere
Ignore Invalid Locations Checked
Restrictions Oneway
Polygon Generation Tab
Generate Polygons Checked
Polygon Type Detailed
Trim Polygons 200 Feet
Excluded Sources None

Multiple Facility Options Overlapping

Overlap Type Disks
Line Generation Tab
Generate Line Checked
Generate Measure Unchecked
Split Lines at Breaks Unchecked
Include Network Source Fields Unchecked
Overlapping Options Overlapping
Accumulation Tab
Length_MI Checked
Minutes Checked
Network Locations Tab
Location Type Facilities
Properties Default for all
Search Tolerance 500 Feet
Snap To Closest
Streets_nw shapefi le Checked

Table 3a: Parameters for 1.5 Mile ISO Service Area
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within 200 feet of an existing road, the travel footprint will be limited to an area defi ned by length 
of the preconnected fi re hoses carried by most structural engines.

In the Network Analyst window, right-click on Polygons to open the Properties dialog box. 6. 
Notice that the SA polygons have been labeled with the 1.5-mile analysis parameter (see 
Symbology tab) and are posted with a 50 percent transparency (see Display tab). Click the 
General tab and rename this layer 1.5 Mile Polygons. Change the transparency to 0 percent. 
Save the map document. Right-click on the Lines layer in the 1.5 Mile ISO Service Area and 
change the line width from 3.00 to 1.00.

In the Network Analyst window, right-click on Facilities, choose Load Locations from the context menu,
and add Fire Stations as locations.
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Move the 1.5 Mile ISO Service Area layer group down in the table of contents below the King 7. 
County Fire District 37 layer. Before moving the group, uncheck its group display box, turn off 
the Fire Hydrants layer, and hide the legend detail to make it move more easily and display 
more quickly.

Right-click on the newly created service area and set the properties on the tabs as shown in Table 3a.

Before building the rest of the Service Areas, perform a basic spatial calculation that counts 8. 
the number of hydrants inside and outside the 1.5-mile polygons. Highlight the Fire Hydrant 
layer and make all 3,495 hydrants visible. From the main menu, choose Selection > Select by 
Location and select features from Fire Hydrants that are completely within the features in
1.5 Mile Polygons. This should select 2,201 hydrants inside the 1.5-mile Service Areas. Choose 
Selection > Clear Selected Features to unselect these features and save the map document.
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The fi rst service is based on distance.

To develop and implement a Standard of Cover, emergency service providers map predetermined 
time-based travel areas around fi xed facilities. King County Fire District 37 maps fi ve- and eight-
minute travel around all existing stations and also maps similar areas around proposed stations to 
defi ne new coverage. Staff determined that time-based travel is measured by averaging travel on 
each street segment applying 80 percent of the posted speed limit. Streets in the sample dataset do 
not include turn restrictions or traffi c calming features, although these features are being mapped by 
the city. 

Creating a Five-
Minute Travel Area
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To defi ne fi ve-minute travel areas, click the 1. 
Network Analyst drop-down list and select 
New Service Area and make sure streets_
nw_ND is the active Network Dataset.

Right-click on locations and choose Fire 2. 
Stations. Right-click on the new SA layer 
group and choose Properties. Rename it
5 Minute Travel Area and go through each 
tab changing parameters as shown in Table 
3b. Be sure to set impedance to fi ve minutes 
and change the trimming distance to
600 feet.

Move the SA group down the table of 3. 
contents to a position just below the
1.5 Mile ISO data.

Highlight the 5 Minute Travel Area layer and 4. 
click the Solve button. Inspect the results 
and tidy up the thematic legend.

Rename the polygons to 5 Minute Travel 5. 
Polygons and save the map document.

This polygon and polyline group shows the fi rst 
due response area for fi re service personnel. 
Nearly all of the city of Kent and much of the 
area east of town is covered. Inspect the 
polygons carefully and notice that there is 
limited overlap. The Standard of Cover for 
Fire District 37 specifi es that a fi rst arriving 
unit (or Distribution) will be on scene within 
seven minutes after an aid request is received 
for at least 80 percent of all calls. Study the 

5 Minute Travel Area Wizard Settings
Analysis Settings Tab
Impedence Minutes

Default Breaks 5

Direction Away From Facility

Allow U-Turns Everywhere

Ignore Invalid Locations Checked

Restrictions Oneway

Polygon Generation
Generate Polygons Checked

Polygon Type Detailed

Trim Polygons 600 Feet

Excluded Sources None

Multiple Facility Options Overlapping

Overlap Type Disks

Line Generation
Generate Line Checked

Generate Measure Unchecked

Split Lines at Breaks Unchecked

Include Network Source Fields Unchecked

Overlapping Options Overlapping

Accumulation
Length_MI Checked

Minutes Checked

Network Locations
Location Type Facilities

Properties Default for all

Search Tolerance 500 Feet

Snap To Closest

Streets_nw shapefi le CheckedTable 3b: Parameters for 5 Minute Travel Area
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Fire Stations attribute table to understand the 
apparatus and staffi ng available for fi rst due 
response.

The next step is modeling eight-minute travel to 
analyze combined response capabilities, relying 
on equipment and personnel from multiple 
stations. This portion of the exercise models 
combined response. This allows units three extra 
minutes to arrive and deploy and lay attack lines 
600 feet from apparatus. 

Close the 5 Minute Travel Area group and 1. 
create a new SA as described in the two 
previous sections. 

Name this group 8 Minute Travel Area and 2. 
set analysis parameters as shown in
Table 3c. Be sure to set the trimming 
distance on the Polygon Generation tab to 
600 feet.

Reposition the 8 Minute SA just below the3. 
5 Minute analysis and click the Solve button. 
This solution will require slightly more time 
because it will cover more distance and entail 
signifi cantly more overlapping coverage. 
When this routine fi nishes, tidy up the 
legends, rename the polygons to 8 Minute 
Travel Polygons, and inspect the results. 

Observe the extensive overlap between 4. 
stations. These relationships, called 
Concentration in Standard of Cover terms, 
can also be modeled. King County Fire 

Measuring Eight-
Minute Travel

8 Minute Travel Area Wizard Settings
Analysis Settings Tab

Impedence Minutes

Default Breaks 8

Direction Away From Facility

Allow U-Turns Everywhere

Ignore Invalid Locations Checked

Restrictions Oneway

Polygon Generation
Generate Polygons Checked

Polygon Type Detailed

Trim Polygons 600 Feet

Excluded Sources None

Multiple Facility Options Overlapping

Overlap Type Disks

Line Generation
Generate Line Checked

Generate Measure Unchecked

Split Lines at Breaks Unchecked

Include Network Source Fields Unchecked

Overlapping Options Overlapping

Accumulation
Length_MI Checked

Minutes Checked

Network Locations
Location Type Facilities

Properties Default for all

Search Tolerance 500 Feet

Snap To Closest

Streets_nw shapefi le CheckedTable 3c: Parameters for 8 Minute Travel Area
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District 37 exhibits excellent Distribution 
and Concentration as defi ned by its 
Standard of Cover, especially after the 
construction of several new stations. The 
total available response for fi refi ghting force 
can be determined by summing all available 
personnel responding within overlapping 
eight-minute travel areas.

The fi nal process in this exercise will model 
optimum response areas based on a 10-minute 
travel limit from each station. In this analysis, 
apparatus from each station will drive outward on 
all streets until each meets apparatus from a 
neighboring station. Time-based travel polygons 
show optimum response areas for all stations. In 
many fi re departments, each station is 
responsible for testing and maintaining fi re 
hydrants within its response area. Counting the 
hydrants within each station's optimum area will 
help determine if some stations have signifi cantly 
more hydrants to inspect.

From the Network Analyst drop-down list, 1. 
create another Service Area and name it
10 Minute Optimum Response Area.

Modify the parameters in the Layer 2. 
Properties dialog box as shown in
Table 3d. Pay special attention to the 
Polygon Generation tab. On that tab, keep 
the trim distance at 600 feet, and under 
Multiple Facilities Options, select Not 
Overlapping. 

Mapping Optimum 
Response Areas

10 Minute Optimum Response Area Wizard Settings

Analysis Settings Tab
Impedence Minutes

Default Breaks 10

Direction Away From Facility

Allow U-Turns Everywhere

Ignore Invalid Locations Checked

Restrictions Oneway

Polygon Generation
Generate Polygons Checked

Polygon Type Detailed

Trim Polygons 600 Feet

Excluded Sources None

Multiple Facility Options Overlapping

Overlap Type Disks

Line Generation
Generate Line Checked

Generate Measure Unchecked

Split Lines at Breaks Unchecked

Include Network Source Fields Unchecked

Overlapping Options NOT Overlapping

Accumulation
Length_MI Checked

Minutes Checked

Network Locations
Location Type Facilities

Properties Default for all

Search Tolerance 500 Feet

Snap To Closest

Streets_nw shapefi le CheckedTable 3d: Parameters for 10 Minute Optimum Response Area
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Move this layer below the 8 Minute Travel Area group and click the Solve button. 3. 

When processing is fi nished, right-click on Polygon to open the Layer Properties dialog box and 4. 
rename it 10 Minute Optimum Polygons. 

Close the Network Analyst window. Load the prebuilt Layer fi le from the sample dataset to 5. 
create a thematic legend for this data. Save map.

After creating the 10 Minute Optimum Response Area, apply its prebuilt legend,
10 Minute Optimum Polygons, to the polygons.
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This tutorial has performed several of the analyses that a public safety provider might perform to 
measure its effectiveness. Additional tasks might include measuring effective response force, 
experimenting with Concentration variables including repositioned apparatus and personnel, and 
comparing historic response times to modeled values. To perform these analyses on your own data, 
start building and testing network datasets, mapping fi re stations and hydrants, and compiling 
historic response data.

Developing a Standard of Cover
Quick response to fi res and medical 
emergencies limits suffering. Emergency 
service providers strive to provide similar 
levels of service in all areas of a city. 
Equity, timely service, and integrated 
response are the goals when planning 
emergency service distribution.

A Standard of Cover (SOC) is a plan 
that includes mapping and modeling of 
distribution (e.g., fi rst due responders) and 
concentration (e.g., multiple responders) 
of fi eld resources. An SOC also addresses 
the values, hazards, and associated risks 
within the community. A successful SOC 
must show how lives will be saved and 
property protected, while responders are 
operating in a safe and timely manner. 

The Commission on Fire Accreditation International (CFAI), a member of the Center for Public 
Safety Excellence, guides and certifi es emergency service providers and designs, implements, and 
supports an effective SOC.

The City of Kent Fire Department and King County Fire District 37 in south King County, 
Washington, began considering the CFAI accreditation process in fall 1997 after a self-assessment 
workshop was held. Most of the workshop attendees were Kent Fire Department personnel along 

Future Activities
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with personnel from surrounding agencies. Accreditation tasks began in 2001, and following the fi rst 
peer review, the agency was accredited in August 2004. The district was only the fourth accredited 
agency in the state.

The accreditation documentation for the City of Kent Fire Department and King County Fire District 
37 totaled more than 800 pages of self-assessment information and a dynamic 200-page SOC 
document. GIS mapping was used extensively to support both documents. The district is currently 
updating all maps and performance history. It recently completed its annual compliance report and 
continues building on the original recommendations. The new Information and Strategic Services 
Unit now implements the recommendations made by peer assessors. GIS enables agency staff as 
they track recent performance and plan future resource deployment throughout a rapidly growing 
and changing community.

The author thanks the administration and staff of King County Fire District 37, South King County, 
Washington, and the many Fire District 37 and City of Kent staff who provided data for this exercise 
as well as the Commission on Fire Accreditation International and ESRI's Public Safety Marketing 
Group for its continued support of new developments in Standard of Cover GIS mapping.

(Reprinted from the October–December 2006 issue of ArcUser magazine)
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Managing Volunteer Firefi ghter Response
Using the OD Cost Matrix to Model Personnel Availability

By Mike Price, Entrada/San Juan, Inc.

Emergency responders try to arrive on the scene of a fi re or other emergency as quickly and safely 
as possible. Career fi refi ghters respond on a 24/7 basis from fi re stations or apparatus in the 
fi eld. Volunteer responders, who include fi refi ghters and emergency medical technicians, typically 
respond from homes, workplaces, or random locations. 

Depending on department policy and response parameters, volunteers may respond to incidents 
in privately owned vehicles (POVs) or drive in a POV to a nearby fi re station and respond in 
emergency apparatus. The additional time required for a volunteer responder to travel to a station 
to pick up emergency apparatus must be factored into a response model. Volunteers are not 
always available on a consistent schedule, and this must be considered when mapping an effective 
fi refi ghting force.

The ArcGIS Network Analyst extension has an Origin-Destination (OD) cost matrix function that 
allows public safety GIS personnel to accurately determine and map travel times and distances 
from volunteer locations to a fi re station. The OD cost matrix also determines optimal apparatus 
travel time to historic incidents and to hypothetical or staged scenarios, thereby validating historic 
data and supporting the design of response alternatives.

The Moab Valley Fire Protection District (MVFPD) protects lives and property from fi re, fl ood, man-
made, and natural disasters in an approximately 30-square-mile district. The district encompasses 
the entire resort destination city of Moab, Utah, and adjacent lands in Grand County outside the 
city limits. According to 2000 census fi gures, the district's permanent population is 7,723 people 
and another 209 people live in the district's contract response areas. The Fire Department roster 
averages 40 volunteer fi refi ghters, based in two fi re stations. The department maintains three 
full-time employees and operates a fl eet of 16 vehicles, and the district maintains three full-time 
employees.

The exercise presented here uses modifi ed fi refi ghter residence locations and actual fi re station 
sites in Moab to map and model volunteer response parameters. Although personnel data has been 
masked to ensure privacy, its composition and geographic distribution are realistic.
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This article models volunteer response 
using data from Moab, Utah.
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Functionality in the ArcGIS Network Analyst extension for calculating travel times and/or distances 
between families of origin and destination points was available at ArcGIS 9.1 and updated in
ArcGIS 9.2. This group function, the OD cost matrix, quickly provides emergency service providers 
with measures of staff availability and response effectiveness. The procedure employs the same 
high-quality network dataset that emergency managers use for determining service areas, optimal 
routing, and other tasks.  The OD cost matrix requires careful mapping of origin and destination 
point locations. The matrix records time and distance data for each pair of points and maps a two-
node polyline connecting the endpoints.

Two primary uses for the OD cost matrix in public safety involve managing personnel and fi re 
response preplanning. Emergency managers continually track availability of resources including 
volunteer responders. The OD cost matrix calculates travel times and distances for volunteer 
personnel traveling in personal vehicles from homes and offi ces to a station. 

The OD cost matrix also calculates optimal travel times along shortest routes for historic incident 
responses; it provides a framework to confi rm whether incident time tracking is accurate and 
determines where performance might be improved. This exercise shows how the OD cost matrix 
maps and assesses volunteer fi refi ghter availability in a rural community that has 40 fi refi ghters who 
will respond to any of three fi re stations from their homes.

To add a bit of sophistication, this exercise will also use joined tabular data for determining travel 
parameters for a rotating Offi cer in Charge and available responders from a weekend roster. In 
practice, this model should be expanded to include work addresses and other predictable time-
based locations for responders.

Network Analyst and 
the OD Cost Matrix
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1. Download the sample data for this exercise from ArcUser Online at www.esri.com/arcuser. 
Unzip the archive fi le in the root directory. Open ArcCatalog and inspect the fi les. The sample 
dataset contains one dBASE fi le, a topography hillshade grid, many Layer fi les, several 
shapefi les, and a startup ArcMap document. All data is registered in Utah State Plane Central 
Zone. The datum is North American Datum 1927, and units of measure are U.S. Feet.

Using ArcCatalog, inspect the data attributes to verify they will support time-based networking. 2. 
Navigate to \MoabFire\LYRFiles\  and locate the Highways, Streets :Layer fi le and preview its 
attribute table.

In the Highways, Streets attribute table, use Calculate Geometry to 
calculate the contents of the LENGTH_FT fi eld.

Getting Started
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Scroll right and notice that this table contains fi elds for geocoding addresses. These streets are 3. 
a subset of streets mapped by Grand County's Road Department as part of a U.S. Geological 
Survey rural transportation prototype program. This data is used by Grand County Emergency 
Management for geocoding incidents. The Speed_MPH column will be used to calculate travel 
time along segments. The three rightmost columns—Length_FT, Length_MI, and MINUTES—
contain zeroes and will be used to record impedance data: segment length in U.S. feet and 
miles and travel time in minutes. 

Inspect the roads1_ND in ArcCatalog.
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Preview the table for the Fire Stations layer. The Moab Valley has two existing stations and one 4. 
proposed station, now occupied by a temporary apparatus facility. The Index and Label fi elds 
are very helpful for loading locations for network analysis. 

Inspect the Members Residence table. It contains the same Index and Label fi elds. This 5. 
exercise includes data for 40 fi refi ghters including a chief, an assistant chief, two battalion 
chiefs, four captains, four lieutenants, and 28 fi refi ghters. Fields on the right track training status 
including engineering, emergency medical, and hazardous material certifi cations. These fi elds 
will help verify that suffi cient offi cers, engineers, and other specially trained personnel will be 
available during an emergency.

Finally, navigate to \MoabFire\DBFFiles\ and preview Crew_07Q1.dbf. This table lists scheduled 6. 
availability of fi refi ghters on weekends during the fi rst three months of 2007. The number 1 
indicates that a fi refi ghter will be available through the weekend, and a 2 identifi es the Offi cer in 
Charge for that weekend. 

Click on several headers for these columns and choose Statistics from the context menu. More 7. 
than 24 fi refi ghters are available for weekend response on all but two holiday weekends, when 
availability drops to less than 20. (Hint: Subtract 1 from the sum to account for the Offi cer in 
Charge. The sum generated by Statistics represents 23 fi refi ghters and one offi cer.)

Before using ArcCatalog to create the Roads_1 Network Dataset, distances and travel times must 
be calculated in ArcMap. 

Start an ArcMap session and open \MoabFire\MoabFire1.mxd. 1. 

Open the Highways, Streets attribute table and move to the LENGTH_FT fi eld. Right-click on 2. 
this fi eld and select Calculate Geometry, a new ArcGIS 9.2 function. 

Set Property as Length, click on the radio button next to Use Coordinate System of the Data 3. 
Source. Make sure the units are Feet US [ft] and click OK.

Right-click on the LENGTH_MI fi eld header and select Field Calculator. Enter [LENGTH_4. 
FT]/5280 in the formula box, click OK, and check these calculations.

Calculate the travel time in minutes for each segment by opening a Field Calculator for the 5. 
MINUTES column and entering [LENGTH_MI]*(60/[SPEED_MPH]) in the formula box. Click 
OK, check the fi nal calculations, and return to ArcCatalog. 

Calculating Distances 
and Travel Times
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In the ArcCatalog Catalog tree, move to /SHPFiles/UTSP27CF/, open roads1 and preview its table, 
particularly the rightmost fi elds. 

Right-click on roads1 and select New Network Dataset. Accept default parameters for 1. 
Connectivity, Connectivity Elevation, and Turns.

On the Attributes Setting pane, Minutes is a Network Analyst keyword. This fi eld will be included 2. 
in the dataset. Specify the distance parameter by clicking the Add button and typing Length_Mi 
in the Name box. Set the Units to Miles, accept other default parameters, click OK, and click 
Next.

Specify driving instructions and capture the text in the Summary screen into a WordPad 3. 
document for future reference. Click Finish and build the new Network Dataset.

Inspect the new Network Dataset. For more information about creating network datasets, 4. 
read "Got It Covered—Modeling Standard of Cover with ArcGIS Network Analyst 9.2" in 
the October−December 2006 issue of ArcUser, available online at www.esri.com/news/
arcuser/1006/fi les/covered.pdf.

Creating a Network 
Dataset
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The author thanks the Moab Valley Fire Protection District and Grand County Emergency Management for
providing representative data for this activity. All personnel data has been synthesized for training

purposes and any resemblance to actual conditions is accidental.
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Return to the ArcMap document, MoabFire1. Check that a license for an ArcGIS Network Analyst 
extension is available, display the Network Analyst toolbar, and open the Network Analyst window 
by clicking the Network Analyst window.

Click the Add Data button and locate the /roads1_ND.ND in /SHPFiles/UTSP27CF and add it to 1. 
the project. Because this project already includes the source roads and won't use intersection 
nodes, do not add other feature classes. Verify that the Network Dataset has successfully 
loaded. 

Click the Network Analyst drop-down menu and select New OD cost matrix. Right-click on 2. 
Origins in the Network Analyst window and select Load Locations. Select Member Residences 
as the Origin set, specify INDEX as the Sort Field and LABEL as the Name fi eld, and set 
Search Tolerance as 500 Feet. Verify that 40 member origins load successfully.

Load the Destination Fire Stations using parameters in Table 1. Verify that three stations are 3. 
properly mapped.

Parameter Value
Load From Fire Stations
Only Show Point Layers Checked
Location Analysis Properties Curb/Approach (Default) Name (LABEL)
Location Position Use Geometry
Search Tolerance 500 Feet

Table 1: Values for loading Destination Fire Stations.

Now move the OD Matrix group below the Member Residences and Fire Stations layers in the table 4. 
of contents. Save the map document.

Return to the table of contents and right-click on the OD cost matrix group name. Under the 5. 
General tab, rename it Firefi ghter Residence OD cost matrix. Accept defaults for the Layers and 
Source tabs and open the Analysis Settings tab and set them as shown in Table 2. Click the 
Accumulation Attributes tab and check both Length_Mi and Minutes, inspect Network Locations, 
and click OK to set all parameters.

People and Places—
Mapping Response 

Resources
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Parameter Value
Impedance Minutes(Minutes)
Default Cutoff Value <None>
Destinations to Find <All>
Allow U-Turns Everywhere
Output Shape Type Straight Line

Table 2: Analysis Settings tab.

Solve the OD cost matrix by right-clicking on its name and selecting Solve or by clicking the 6. 
Solve button on the Network Analyst toolbar. Save the map document.

1. Open the attribute table for the Lines layer of the Firefi ghter Residence OD Matrix group. 
Inspect fi elds and observe that there are a number of informative fi elds including the Name of 
the fi refi ghter and the modeled station, each fi refi ghter's OriginID (i.e., the fi refi ghter residence 
index), a DestinationID (the fi re station index), a DestinationRank, TotalMinutes, and Total_
Length_Mi. 

Tidy up the OD vectors to highlight each station set with a different color. Minimize the table 2. 
and open Lines Properties. Select the Symbology tab and change to a Unique Values legend. 
Specify DestinationID as the Value Field and specify 2 point lines for values 1, 2, and 3 
(Stations 1, 2, and 3, via indexing). Select a bright red for 1, green for 2, and blue for 3 to show 
the connection between each fi refi ghter's home and all stations.

Return to the Lines table and experiment with this data. Try to fi nd the closest fi refi ghter to each 3. 
of the three stations. Who lives the farthest in time and distance from Station 1? Which station 
is closest to each fi refi ghter's home? (Hint: Query for DestinationRank = 1; do you think that this 
time-based response information might help resolve a few arguments?)

Mapping Responders
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The next step is to model each fi refi ghter's weekend availability. 

Load a table listing each volunteer's status on weekends by clicking the Add Data button and 1. 
selecting Crew_07Q1.dbf from \MoabFire\DBFFiles\. 

Open this table and inspect it. It includes fi elds for Label, Rank, and the helpful Index. Fields to 2. 
the right of Rank contain fl ags listing the weekend Offi cer in Charge (coded with 2) and available 
fi refi ghters (coded with 1). 

In the table of contents, right-click on the Member Residences and choose Joins and Relates > then 3. 
Join. Select INDEX as the fi eld that the Join will be based on, specify Crew_07Q1 as the table to 
join, and select INDEX as the key fi eld in the joined table. Click OK and verify the join by opening 
the attribute table. 

Repeat this process with the OD Matrix Lines. Select OriginID as the fi eld that the Join will be 4. 
based on, specify Crew_07Q1 as the table to join, and select INDEX as the key fi eld in the 
joined table. Click OK and verify the join. 

With the weekend availability data joined to Member Residence points and OD Matrix Lines, defi nition 
queries can be applied that will show staff availability. Let's start with the fi rst weekend in January. 

Double-click on Member Residences, click the Defi nition Query tab. Click the Query Builder 1. 
button and use the interface to create the query "Crew_07Q1.A_070106" >0 that will display all 
fi refi ghters available for the weekend. Click OK. 

Review the selection. Can you fi nd the Offi cer in Charge this weekend? What is his/her rank 2. 
and Engineer/Driver status? How far is the offi cer's home from Station 1, in terms of time and 
distance? This query locates the offi cer's home, rank (e.g., battalion chief), and engineer training 
but cannot display travel time to Station 1. 

Enhancing Response 
Data with Tabular Joins

Finding Firefi ghters—
Defi nition Queries 

Using Tabular Joins
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After creating the roads1_ND, click the Network Analyst drop-down menu and select
New OD cost matrix, right-click on Origins in the Network Analyst window,

and select Load Locations to load the fi refi ghter residence locations.
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Symbolize the Lines in Firefi ghter Residence OD Cost Matrix layer to show the connection between 
each fi refi ghter's home and all stations.

To map drive times for POVs requires building a second defi nition query for the OD Matrix Lines. 3. 
Create this defi nition query by using the initial query to produce the expression "Crew_07Q1.
A_070106" >0 AND ODLines.DestinationID=1
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This map identifi es the fi rst four fi refi ghters arriving at Station 1 and the residence location of the weekend offi cer.

Inspect the results and locate FF 22. This offi cer's drive time is 2.27 minutes over a distance of 4. 
1.66 miles. Other responders should arrive at the station ahead of the weekend offi cer.
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This map shows routes to the closest station for all January 6 fi refi ghters. It also shows fi refi ghter status including 
engineers, EMTs, and hazmat technicians.

To map fastest responders, locate the ODLines.Total_Minutes fi eld in the Lines table and sort it 5. 
in ascending order. Assuming that four fi refi ghters should be on an engine before it responds, 
manually select the top four records and look at them on the map. The travel time for the fourth 
arriving fi refi ghter is 2 minutes; 11 seconds is the lag time between the time all fi refi ghters leave 



NOVEMBER 2009  FIRE MAPPING52

their homes and the arrival time of the fourth crew member. This makes a basic assumption that 
all fi refi ghters take the same time to react to the call and begin driving their POVs. 

Included in the sample dataset are Layer fi les to map available fi re offi cers, engineers, fi refi ghters/
emergency medical technicians, and hazmat technicians. Load these Layer fi les, then relink these 
layers to the members1.shp. Create your own staffi ng questions and remap the data. 

As a challenge exercise, create tabular joins to Crew_07Q1.dbf and create defi nition queries for 
other weekends. Experiment with responses to other stations on different weekends. Pay special 
attention to the holiday weekends, January 13 and February 17, when a minimum number of staff 
members are in town and decide if staffi ng is adequate to handle the wide variety of emergency 
situations that confront Moab fi refi ghters.

Moab's Fire Department provides exceptional service to Valley residents, relying largely upon 
volunteer staff. Dedicated personnel, a high level of training, and careful planning make it all 
possible. This article demonstrates one use of the Network Analyst OD cost matrix to answer real-
world questions. The OD cost matrix has other uses in emergency management that may be the 
subject of future articles.

(Reprinted from the April–June 2007 issue of ArcUser magazine)

Making a Pretty Map 
and Experimenting 

with Availability Data

Summary
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Do It Yourself!
Building a Network Dataset from Local Agency Data

By Mike Price, Entrada/San Juan, Inc.

 
Tutorials in recent issues of ArcUser magazine have showed how 
to create mapped time- and distance-based travel network models 
for emergency response applications. Building these models 
required carefully prepared agency or commercial street data that 
had been tuned for network modeling.

Many local agencies build and maintain quality street datasets, 
often designed to support highly reliable geocoding. While these 
streets can be very current and have great positional accuracy, 
they are often not built to support time- and distance-based 
networking. However, in many cases, 
it is possible to modify these street 
datasets to support a network model.

This exercise uses a street dataset 
for Redlands, California, where ESRI 
is headquartered. The Redlands City 
GIS streets data was designed and 
is maintained for address geocoding. 
After inspecting the data, the 
exercise explores several methods 
for modifying a copy of the data for 
time-based networking. This exercise 
involves careful heads-up editing. 
The Redlands street data in the 
sample dataset has been modifi ed 

This exercise explores several methods for modifying street data for use in 
time-based network modeling.
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only slightly so exercise tasks can be accomplished more quickly. It is very similar to the original 
Redlands street dataset.

This article assumes a basic understanding of ArcGIS Desktop and the ArcGIS Network Analyst 
extension. To review modeling travel networks with ArcGIS Network Analyst and the concepts of 
distribution and concentration, please read and work the exercises published in the July–September 
2007, October–December 2007, and Summer 2008 issues of ArcUser and available online at www
.esri.com/arcuser. These articles provide background information on how emergency responders 
use time as a response measure.

To obtain the sample dataset for this exercise, visit the ArcUser Online Web site at www.esri.com/
arcuser and download redlands.zip. This fi le contains all the data necessary to perform this tutorial. 
Unzip this data archive near the root directory on your hard drive. In Windows Explorer, right-click 
on the Redlands folder; choose Properties; and on the General tab, make sure Read Only is 
unchecked.

Open ArcCatalog and navigate to the Redlands folder. Preview the data in Geography and Table 
modes. Notice that the data is in California State Plane North American Datum of 1983 (NAD 83) 
Zone V and units are U.S. Survey Feet. Preview the Redlands01.mxd fi le to see the study area for 
the exercise. 

Locate and carefully inspect the streets shapefi le. This geocoding dataset was created and 
maintained by the City of Redlands. To protect the original fi le, make a copy of streets_in and 
rename it streets_nw. The copied fi le, streets_nw, will be used for this exercise. 

While in ArcCatalog, add three attributes to support the network model. Preview the streets_nw 
attribute table. In the Catalog tree on the left, right-click on streets_nw, choose Properties, and click 
the Field tab. Notice that the lowermost (rightmost) fi eld in the source table is ADDRCITY. The three 
new fi elds will support directional time and distance networking.

Click the fi rst blank line in the Field Name column and name the fi rst new fi eld OneWay. Specify 1. 
the data type as text and the fi eld length as four characters. Click Apply. This fi eld will be used 
to code travel direction for all one-way streets.

Click in the next blank name fi eld and type “Length_Mi.” Specify a Double format with a 2. 
Precision of 12 and a Scale of 6. Click Apply.When the length of each street segment is 
calculated in decimal miles later in this lesson, this fi eld will hold those results. These values will 
be used to calculate travel time for all segments.

Getting Starting

Adding Fields for 
Results
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Add a third fi eld; name it Minutes; and set its type to Double, with a precision of 12 and a scale 3. 
of 6. This fi eld stores calculated travel times for each segment. Click Apply and OK. Close 
ArcCatalog.

What You Will Need
• ArcGIS (ArcView, ArcEditor, or
  ArcInfo license levels)
• ArcGIS Network Analyst extension
• Sample data from ArcUser Online
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Start ArcMap, turn on the Network Analyst extension, and make the Network Analyst toolbar visible. 
Open Redlands01.mxd and verify that all data layers have loaded properly, including the two layers 
that display the network streets. The Streets with Speed layer will be visible and the Streets with 
Speed and Direction layer will be unchecked. Double-click on any layers that have a red 
exclamation point, choose Properties > Source, and click Set Data Source to repair the path to the 
data.

Switch from Layout View to Data View and open the attribute table for the Streets with Speed layer. 
Study all the fi elds for this layer.

Verify that the three new fi elds are available and contain either zero values or no text. Inspect all 
fi elds and look for information that will support geocoding and a time/distance network. This dataset 
contains speed limit [SPEED_MPH], street class [CLASS], and school zone [SCHOOLZONE] fi elds 
that can participate in the network. However, it does not contain any numeric values for distance. 
The TYPE fi eld provides clues that it contains some directional streets. Select fi elds where [TYPE] = 
‘FRWY’ or [TYPE] = ‘RAMP’ and notice that these records do not contain geocoding attributes. They 
can be edited without upsetting the geocoding fi elds.

Notice that there is no distance fi eld in the source dataset. The Length_Mi fi eld added earlier needs 
to be populated, but before calculating street segment lengths, many of the freeway vectors need to 
be edited.

Sort the [SPEED_MPH] fi eld in ascending order and carefully review the values. Notice that nine 
records have 0 speed limit. Before building the network, these records must be updated or deleted. 
Just remember that they are now in the street dataset. The [SPEED_MPH] fi eld will provide the 
primary impedance and a zero speed will not contribute to a meaningful time. Once directionality 
and connectivity issues are resolved, the segment length in miles and travel time in minutes can be 
calculated.

Because this is a geocoding dataset, it does not contain fi elds for nonintersecting crossings (which 
are also called z-elevations). Although two z-elevation fi elds could be added to this table, it would 
require careful editing of all the values for each crossing and intersecting street segment—a 
complex, time-intensive process. Instead, geometry—not attribution—will be used to defi ne and 
manage crossing relationships.

Examining Distance 
and Speed, Street 
Class, Street Type

Impedance—
Distance

Impedance—Speed

Crossing 
Relationships
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To properly create a network, all street segments must share common endpoints. Make the Streets 
with Speed layer selectable and zoom in or use the Magnifi er Window to inspect intersections. 
Select street segments to verify connectivity. Notice that even freeway interchanges display 
connectivity where they cross city streets. Later in the exercise, freeway segments will be spanned 
across city streets to limit connectivity.

This exercise will limit connectivity by merging freeway segments across city 
streets.  These selected examples show connectivity.

Open the Layer Properties dialog box for the Streets with Speed layer, click on the Display tab, and 
set the transparency for the layer to 70 percent. Turn on the Streets with Speed and Direction layer. 
Zoom in and inspect streets near the I-10 and I-210 freeway interchange. Study the endpoint arrows 
and notice that not all segments are properly oriented for right-hand travel. This must be fi xed. The 
OneWay fi eld will be used to code all one-way segments.

Connectivity

Directionality
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Study the endpoint arrows and notice that some segments are properly oriented for 
right-hand travel, while some are not.

Turns and intersection slowdowns are important in a time-based network. After updating streets in 
the next section, the next step will be building a network using global turns. Save the Redlands01
.mxd before going on to the next section.

Open the Editor toolbar by choosing View > Toolbars > Editor, and choose Start Editing from the 
drop-down to start an editing session. Use the Selection tab in the table of contents to make only 
the Streets with Speed and Direction layer selectable.

Turns and Turn 
Relationships

Editing the Streets 
with Speed and 
Direction Layer
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Open the attribute table for the Streets with Speed and Direction layer and inspect the new fi elds 
(Length_Mi, OneWay, Minutes). Locate all records where SPEED_MPH = 0. Zoom to and inspect 
each record. Decide whether to increase the speed limit or delete the record. If the choice is 
increasing the speed limit, use 10, 15, or 20 mph.(Hint: Delete Redlands Mall and Santa Ana Wash; 
set all other speeds to 10 mph.) Save the map document.

Delete Redlands Mall and the Santa Ana Wash; set all other speeds to 10 mph.

Now to properly orient all freeway and ramp street segments. There are several segments of one-
way streets in downtown Redlands that will be validated.

1. Before beginning an editing session, set a sticky move tolerance that will prevent accidentally 
moving a segment while modifying its orientation. In the Editing toolbar, select the Editing drop-
down and open Options. Set the snapping tolerance to 50 feet and the sticky move tolerance to 
100 pixels.

Speed Limits

Directionality
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2.  Close the attribute table for Streets with Speed and Direction and zoom in to the freeway 
interchange area. Study the segments displaying directional arrows. In the Editor toolbar, set 
the editing target as the Streets with Speed layer (which is a nonselectable layer) and specify 
the task as Modify Feature. Select an improperly oriented street segment. Notice that the red 
node also shows the downstream end of the selected segment.

3.  To fl ip a segment, verify that the 
nodes are displayed and select 
the Edit tool (this tool has a black 
arrowhead icon and is usually 
located to the right of the Editing toolbar drop-down).

4.  Carefully position the mouse cursor near the line’s midpoint. (Hint: Look for the small x.)

5.  Right-click and select Flip from the context menu. The red leading node swaps ends with the 
arrow, which indicates the line has reversed direction. Deselect this line.

Set the snapping tolerance to 50 feet and the 
sticky move tolerance to 100 pixels.

Set the editing target to Streets with Speed and Direction and specify the Modify 
Feature task. Select an improperly oriented street segment and notice that the 

red node also shows the downstream end of the selected segment.
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6. Inspect all freeway and ramp segments and fl ip all improperly oriented segments. Caution: Be 
careful not to move any segments. If you think that you might have moved a segment, go to the 
Editor drop-down and choose Undo Move to return the segment to its original location.

7.  Save edits about every 10 fl ips. (Hint: Use the shortcut keys to navigate the map more rapidly: 
C to pan, Z to zoom in, and X to zoom out.)

8.  Check the Task window on the Editor toolbar to be certain that it displays Modify Feature. It will 
probably take 20 to 30 minutes to fl ip all segments.

The city streets in Redlands that show directionality are properly oriented. Inspect street segments 
carefully to ensure this. If you accidentally fl ip a correct segment, simply fl ip it back. Check all on-

Carefully position the mouse cursor tip near the line’s midpoint. (Hint: Look for 
the small x.) Right-click and select Flip from the context menu. Watch as the red 

leading node swaps ends, indicating that the line has reversed direction.
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ramps and off-ramps and watch out for a rest area on eastbound I-10. A OneWay code will be 
assigned to several ramps. Save the edits and the map document.

In the next process, certain freeway and ramp segments will be merged to build correct crossing 
relationships. Do not perform this step before all appropriate directional segments are properly 
oriented.

Reopen an edit session and zoom to the I-10/I-210 interchange. Verify that only the Streets with 
Speed and Direction layer is selectable. Inspect all directional vectors. Use the Select Features tool 
to individually select several directional vectors.

Because all directional vectors share endpoints with other segments, a network built with these 
segments would maintain correct one-way travel, but might include segments that would make 
sharp turns from a limited-access travel lane onto crossing freeways and even city streets. This is 
not good.

Crossing geometries will help fi x this issue. Simply stated, where a limited-access travel lane 
intersects another class of noncontinuous line segments, the limited-access segments will be 
merged to create a single crossing element. If two limited-access segments merge into one, which 
happens with on- and off-ramps, these segments will not be merged.

In the interchange area, study these crossing relationships carefully. Using the Select Features tool, 
highlight two or more continuous segments that make up a ramp in this area. Do not select any 
line segments that cross the ramp segments being selected. Zoom in to make certain all segments 
for that section of ramp are selected. Select elements by beginning at one end of a section of 
continuous segments and select them in the direction of travel.

In the Editing toolbar, click the Editor drop-down and select Merge. Explore the Merge list and verify 
that all segments have the same source name. If the Merge dialog box contains more than one 
feature name, cancel the task and reselect the segments. Click OK to merge the segments and 
inspect the results.

There should be only one arrowhead, pointing onto I-10 in an easterly direction. Continue the 
process of merging lzine segments for all ramps that cross in this interchange, including freeway 
roadways and ramps.

Crossing 
Relationships
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If incorrect segments are accidentally merged, immediately use the Undo button on the standard 
toolbar to correct this problem. Zoom in and pan as necessary and save the map document 
frequently.

When all crossing freeway and ramp segments in the I-10/I-210 interchange have been merged 
to form single crossing elements, follow the rest of I-10 and I-210 and merge all these segments 
also to create single crossing elements. Watch the directional arrow and the red endpoint symbol 
while merging segments. If an endpoint lands in the middle of a merged segment, undo the merge, 
check directionality, and change the segment selected in the Merge dialog box. If segments in an 
interchange contain speed limit changes, merge only segments with the same speed limit.

Remember not to merge any segments across valid limited-access intersections. Undo the selection 
immediately to correct any accidental merges. Advanced users can use the Split tool to disconnect 
segments when needed.

After completing all merging operations, inspect all freeway lands and ramps. Several ramps are 
problematic. It is diffi cult to tell if the feature being merged is part of an interchange or part of a 
crossing relationship. (Imagine how helpful high-resolution imagery would be.) When fi nished, 
stop editing, save edits, and save the map document. Now, length for all Redlands streets can be 
calculated and OneWay attributes can be assigned.

Now segment lengths and travel times can be calculated and directionality codes assigned to the 
OneWay fi eld.

1. Make Streets with Speed and Direction nonvisible, set transparency at 0 for Streets with Speed, 
and make Streets with Speed the only selectable layer. This layer displays all records in 
streets_nw.

2. Open its attribute table, locate the Length_Mi fi eld, and click on its fi eld header.

3. Select Calculate Geometry and specify Property: Length. Use the coordinate system for the data 
frame and specify units as Miles U.S. Click OK to calculate all segments.

4. With length in miles, travel time in minutes can now be calculated. Open the Field Calculator. 
Select the MINUTES fi eld and type

[Length_Mi] * (60/ [SPEED_MPH])

in the formula box. Click OK and check the calculations.

Editing Attributes
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With length in miles, calculate travel time in minutes. 
Select the minutes fi eld, type [Length_Mi] * (60/ [SPEED_MPH]) in the formula box, and click OK.
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5. Now, assign a OneWay code to all limited-access streets. Close the Streets with Speed attribute 
table and open the Streets with Speed and Direction attribute table. This layer also references 
the streets_nw shapefi le, fi ltered to show only limited-access streets and a subset of Redlands 
streets.

6. Create a query that shows only streets where Type = ‘FRWY’ or Type = ‘RAMP’. Use the Field 
Calculator to populate the OneWay fi eld for each selected record with the value FT (a code for 
From-To). Because directionality has been carefully managed for this data, these codes can be 
applied for all the limited access dataset.

Create a query that shows only streets where Type = ‘FRWY’ or Type = ‘RAMP’ and use 
the Field Calculator to populate the OneWay fi eld with the FT (From-To) code 

for each selected record.

7. Assign an FT code to fi ve specifi c Redlands city streets by creating a query where “TYPE” = ‘ST’ 
AND “NAME” = ‘STATE’ AND “PREFIX_DIR” = ‘E’ AND “LEFT_FROM_” <500. Use Field Calculator 
again to place an FT code in the OneWay fi eld for these fi ve records.



NOVEMBER 2009  FIRE MAPPING66

Redlands streets are now ready to be used for building a time-based network. Zoom to the data 
extent, save the map document, and admire the project.

The tasks in this exercise might seem a bit rigorous, but these steps were necessary to create 
a quality network source without compromising the data. Save this enhanced dataset for future 
activities.

A properly oriented network.

In previous exercises, the ArcGIS Network Analyst extension was used to model time and distance 
response from fi xed facilities. Experiment with this network street dataset by creating a network 
dataset from it and using it to work the Routes and Service Areas exercises in previous ArcUser 
articles in this series, noted at the beginning of this article.

Thanks go to Tom Patterson, ESRI public safety specialist, for requesting this exercise and 
obtaining the Redlands data. Special thanks also go to the Redlands GIS staff members for 
providing this excellent dataset and allowing me to prepare and use it for this exercise.

(Reprinted from the Summer 2009 issue of ArcUser magazine)

Summary

Acknowledgments
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Orders

Modeling and mapping public 
safety arrival ordersRun
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By Mike Price, Entrada/San Juan, Inc.

Timely integrated response to emergencies limits suffering 
and damage. GIS helps responding agencies provide better 
service. This is the last in a series of articles, which began in the 
October–December 2006 issue of ArcUser magazine, that have 
demonstrated how fi re departments can model service areas and 
response using the ArcGIS Network Analyst extension.

Run orders allow a public safety agency to predict and map the 
arrival sequence and times for responders traveling to an incident 

from multiple 
locations. 
Previous 
exercises in 
ArcUser used 
optimized 
travel areas 
generated using 
the ArcGIS 
Network Analyst 
extension to 
identify the 
station from 
which the fi rst 
responders 
(i.e., First Due) 
will arrive for a 
given location. 

What You Will Need
• ArcGIS Desktop (ArcView, ArcEditor,
  or ArcInfo license)
• ArcGIS Network Analyst extension
• Sample data downloaded from ArcUser 
  Online
• 500 MB of free disk space

Run orders model response scenarios. This map shows the 
approximate time interval that the fi rst crew on scene will 

wait for the second crew to arrive.
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By sequentially remodeling each First Due provider, Second Due coverage areas can also be 
mapped.

Response modeling beyond Second Due coverage areas has always been diffi cult. In “Do It 
Yourself—Building a network dataset from local agency data,” which appeared in the Summer 2009 
issue of ArcUser, a sample dataset for the city of Redlands, California, was modifi ed so it would 
support time-based travel modeling with ArcGIS Network Analyst 9.3.

Working this exercise requires a basic understanding of ArcGIS Desktop and the ArcGIS Network 
Analyst extension. To review modeling travel networks with ArcGIS Network Analyst, including 
information on distribution and concentration, and to work other exercises in this series, visit the 
Learn How to Mode Networks page (www.esri.com/news/arcuser/avmodel.html).

This exercise extends the street data that was enhanced in the previous exercise to include 
information about arrival orders and times for up to fi ve emergency responders. In addition, areas 
where First Due coverage is within national standards will be identifi ed and backfi lled response 
analyzed when the nearest provider is already on a call. To ensure safe, quick entry into a structure 
by responders, the time lapse between arrival of the fi rst and second units will be determined.

This tutorial shows how to model and map arrival orders for four fi re stations near ESRI’s 
headquarters in Redlands, two western stations in the nearby city of Loma Linda, and one station 
to the east of Redlands in Mentone. It involves a complex workfl ow that includes defi nition queries, 
tabular joins, fi eld and geometry calculations, and data exports. It requires great attention to detail.

Instead of using the dataset produced when working the 2009 Summer issue exercise, use the 
sample dataset for this tutorial available from ArcUser Online. It has been converted from shapefi les 
to a fi le geodatabase and contains several additional fi elds that support run orders, and the network 
dataset used will be built inside a geodatabase feature dataset. Even though the sample dataset is 
small, you will need at least 500 MB of hard drive space to complete this exercise. Also note that 
the Closest Facility solution is complex and will take some time to solve.

Download the sample dataset, Redlands.zip, from ArcUser Online, which contains all the data 
necessary to perform this tutorial. Unzip Redlands.zip near the root of your project folder and 
open its contents in ArcCatalog. Navigate to the Redlands folder, expand the Redlands_Fire 
geodatabase, and preview the Run_Order_Model feature dataset in Geography and Tablemodes. 
As in the previous exercise, the projected coordinate system is North American Datum (NAD) 1983 
California State Plane Zone V, and the unit of measure is the U.S. Survey Foot. 

Getting Starting
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Preview the feature class named Network_Streets, as shown. Notice this street data is very similar 
to the street data used in the exercise in the last issue. With Network_Streets selected, switch to 
table view and explore the table structure. Scroll to the fi elds on the right side and note the new 
fi elds: INDEX, CENT_X, CENT_Y, STAT_01, and TIME_01. All fi elds contain zero values but they 
will soon be populated with the arrival order and times for the fi ve closest stations.

The next step is building the Redlands Network_Dataset in ArcCatalog.

Right-click on Run_Order_Model and select New > Network Dataset. Accept the default name, 1. 
Run_Order_Model_ND, for this feature class.

Continue through the Network Dataset wizard, accepting defaults until you get to the wizard 2. 
pane for specifying attributes for the Network Dataset. With Minutes selected, click the Add 
button. In the New Attribute dialog box, add a new attribute named Length_Mi and set its units 
to Miles and the Data Type to Double. Click OK.

3. Reselect Minutes. Click the Evaluators button and select the Default Values tab. Right-click the 
Turn and choose Type > Global Turn Delay. Click Apply.

4. Press F12 to open the Global Turn Delay Evaluator and type in the delay parameters shown in 
Table 1. Click OK and OK again to return to the dialog box for specifying attributes.

5. Click Next to continue and accept the directions defaults.

6. Click Next, select the summary text, copy and paste it to a WordPad document, and save that 
document with the project.

7. Click Finish and build the network. Inspect it when ArcCatalog has fi nished processing. 

1. Close ArcCatalog and open ArcMap. Navigate to the \Redlands folder and open Redlands01
.mxd. Switch from Layout View to Data View. 

Open the attribute table for the Streets with Speed layer. Scroll to the right, study the fi elds, and 2. 
locate the INDEX, CENT_X, and CENT_Y fi elds.

Right-click on INDEX and open the Field Calculator. Double-click on OBJECT_ID1 to add it to 3. 
the formula box. Click OK to populate this fi eld with a sequential index.

Building the 
Network Dataset

Creating Indexes, 
Generating Centroids, and 

Exporting Data



GIS BEST PRACTICES 71 www.esri.com/public_safety

Right-click on the header for 4. 
CENT_X and select Calculate 
Geometry. Choose X Coordinate 
of Centroid to perform this 
calculation. Use the data frame 
coordinate system (NAD 1983 
StatePlane California V FIPS 
0405) and Feet US as the units 
for this project. Click OK.

Repeat this procedure for 5. 
CENT_Y to calculate values for 
the Y Coordinate of Centroid 
fi eld. Inspect the calculations and 
save the project.

Now, export this table to a 6. 
dBASE fi le so these points 
can be used to map street 
centroid points. In the Attributes of 
Streets with Speed table, click 
the Options button and select 
Export. Specify All Records and 
save the table in the \Redlands\
DBFFiles folder as Network_
Street_Centroids_XY.dbf. Click 
on the Source tab of the table 
of contents (TOC) and add the 
table to the map. 

This tutorial models response from fi re stations in and near 
ESRI’s headquarters in Redlands, California.

Direction Description Seconds
Straight From Local to Local Road across No Roads 0

Straight From Local to Local Road across Local Road 1
Reverse From Local to Local Road 30
Right Turn From Local to Local Road 2
Left Turn From Local to Local Road 4

Table 1: Delay parameters.
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The ArcGIS Network Analyst extension Closest Facility solver requires two input datasets: Locations 
and Facilities. To build run orders, load Fire Stations as Facilities and the street segment centroids 
as Incidents. Determining the fi ve closest facilities to each centroid Incident will involve considering 
seven possible Facilities and almost 6,500 Incidents, so this model might take some time to run. 
On the Source tab of the TOC, right-click on Network_Street_Centroids_XY.dbf and select Display 
XY Data. In the Display X,Y dialog box, set the X Field to CENT_X and the Y Field to CENT_Y. 
Click OK. After processing is complete, open the Network_Street_Centroids_XY.dbf and inspect the 
location of these centroid points. Save the project.

With the XY event theme created, it is time to add the network dataset, load Facilities and Incidents, 
and defi ne the Closest Facility rules. 

If necessary, make the Network Analyst extension active, load its toolbar, and open a Network 1. 
Analyst window.

Click the Add Data button and navigate to the Run_Order_Model_ND, located in the Run_2. 
Order_Model feature dataset, and add it. Don’t add all the feature classes that participate.

In the TOC, place Run_Order_Model_ND just below Streets with Speed layer and make it not 3. 
visible.

Click the Network Analyst drop-down and select New Closest Facility. The Closest Facility 4. 
group is added at the top of the TOC and the Network Analyst window. In the TOC, move the 
Closest Facility to a location just above the Redlands City Limits layer at the bottom of the TOC.

Mapping Incidents

Loading Facilities 
and Incidents

Specify another attribute for the network dataset 
called Length_Mi. With Minutes selected, click 

the Add button and set its units to Miles and the 
Data Type to Double.
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 In the Network Analyst window, right-click on Facilities and select Load Locations. Specify Fire 5. 
Stations and Load From source. Carefully apply the loading parameters listed in Table 2 and 
click OK. Save the project.

Right-click on Incidents and choose Load Locations. Carefully apply the loading parameters 6. 
listed in Table 3 and click OK. This may take considerable time, so be patient. If the process 
hangs, close ArcMap, reopen the last saved project, and load it again. Inspect the loaded 
incident data. If it is correct, save the project again.

Use the Network_Street_Centroids_XY.dbf to create an XY Event layer that will be the 
input for Incident Data needed when calculating Closest Facility.
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1. In the TOC, right-click on 
Closest Facility layer and choose 
Properties.

In the General tab, rename it to 2. 
Run Order Closest Facility. In 
the Analysis tab, set Impedance 
to Minutes, Default Cutoff Value 
to 20, and Facilities to Find to 5. 
Change Travel from to Facility to 
Incident. Accept defaults for all 
other parameters.

In the Accumulation tab, check the Length_ Mi and 3. 
Minutes attributes. Click Apply to save these parameters. 
Click OK. Save the project. In the TOC, right-click on 
Closest Facility and choose Solve. Now it’s time to take 
a break. There are literally thousands of routes in this 
solution so this process may take more than 20 minutes. 
Close Warning Message that lists the centroid points not 
reached in 20 minutes. Once the process has fi nished, 
save the project. 

Open the Routes table. If it contains approximately 4. 
32,000 routes and everything else looks OK, save the 
project again. The ArcMap document has just increased 
in size from about 2 MB to more than 100 MB.

Defi ning the Closest 
Facility Solver 

Parameters

Carefully fi ll out the dialog box when loading Fire 
Stations for Closest Facility analysis.

Parameter Value
Load From: FireStations

Sort Field: INDEX
Location Position: Use Geometry
Name (under Location Analysis Properties): LABEL

Search Tolerance: 500 Feet

Table 2: Facilities loading parameters.
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Carefully study each fi eld of the Routes attributes. This data will be used to build run orders for each 
street segment. Notice that the FacilityID fi eld corresponds to the Index fi eld in the Fire Stations 
table. The IncidentID fi eld connects to the Streets Index. The FacilityRank lists arrival order, and 
Total_Minutes contains the travel time for each station to each centroid. Open the Fire Stations 
table and place it above the Routes attributes.

Before exporting arrival data for First through Fifth Due, join station names, apparatus, and 1. 
personnel to each route.

Joining Station 
Information to Each 

Route

Be patient while several thousand centroids load.

Carefully fi ll out the dialog box when loading the 
Network_Street_Centroids_XY.dbf for 

Closest Facility analysis.



NOVEMBER 2009  FIRE MAPPING76

To join Fire Station data to the Routes, right-click on Routes in the TOC and select Join.2. 

Parameter Value
Load From: Network_Street_Centroid_XYEvents

Sort Field: INDEX
Location Position: Use Geometry
Name (under Location Analysis Properties): LABEL

Search Tolerance: 500 Feet

Table 3: Incident loading parameters.

Carefully set the Closest Facility Solver parameters.



GIS BEST PRACTICES 77 www.esri.com/public_safety

In the Join Data dialog box, choose Facility ID as the fi eld in this layer that the join will be based 3. 
on, choose Fire Stations as the table to join to the layer or load the table from, and choose 
INDEX as the fi eld in the table to base the join on and choose Keep all records.

Join the fi ltered dBASE fi les to the Street with Speed layer 
to calculate values, then remove the join.

Click OK, allow indexing, and inspect the Routes table. 4. 

With the Station Number (STATION_N) for up to fi ve responders for each modeled street segment, 
the next step is the crux of this entire procedure.
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Now to export the fi ve tables, one for each arrival order, individually join each table to the streets, 
and calculate station and travel time for each arrival. After successfully joining Routes to Fire 
Stations, the next step is to apply a defi nition query to fi lter the Routes attributes by arrival and 
export each subset to a separate dBASE table.

In the TOC, right-click on Routes and choose Properties. Click the Defi nition Query tab. In the 1. 
formula box, request all records where CFRoutes.FacilityRank = 1. This subset represents 
travel records for fi rst-on-scene stations. Times should be short, especially near fi re stations.

The next step is to export the First Due records. In the fi ltered Routes attribute table, click 2. 
Options and select Export. Save the exported table to Redlands\DBFFiles and name it RO_01
.dbf. Do not add the table to the map yet.

Reset the defi nition query to CFRoutes. FacilityRank = 2 and export again, saving as RO_023. 
.dbf. Again, don’t add the table to the map. 

Repeat this procedure for RO_03, RO_04, and RO_05. Now, add all fi ve RO fi les to your map. 4. 
Save the project again.

Exports and Joins

In the TOC, right-click on Routes and select Defi nition Query. In the formula box, request all records where CFRoutes.FacilityRank = 1.
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Use the Field Calculator to calculate the delay time between First Due and Second Due.

The fi nal analytical steps include fi ve separate joins, each followed by two quick calculations. 
Perform each operation carefully and check the data!

Open and inspect the attribute table for Streets with Speeds. Locate the STAT_01 and TIME_01 1. 
fi elds. Open and position RO_01.dbf below the streets attributes. 

Right-click on Streets with Speed layer in the TOC and select Joins and Relates. Verify that 2. 
there are no active joins for this table. (If there are any joins, remove them.) Next create a Join 
with RO_01, using INDEX as the Streets with Speed join fi eld, RO_01 as the table to join, and 
IncidentID as its join fi eld. Click OK to continue. Do not index this table. Open the table and 
verify the join.

Populating Station 
and Time Fields with 

Joined Table Data
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In the joined table, navigate to STAT_01 and right-click its header. Select Field Calculator and 3. 
populate the RO_01.STATION_NO fi eld with values from Network_Streets. STAT_01.

Next, use the Field Calculator to populate the TIME_01 fi eld with the values from the RO_014. 
.Total_Minu fi eld. Check the work. Null records represent streets that were not traversed within 
20 minutes.

5. Now for a really important step. In the TOC, right-click Streets with Speed, select Joins
  and Relates, and remove the RO_01 join. Do not skip this step.

6. Create new joins on Streets with Speed to the other RO tables using INDEX as the fi eld the join 
is based on, the RO table (e.g., RO_02, RO_03), and IncidentID as the fi eld in the table to base 
the join on. Populate the station (STAT_0x) using the formula Header = STAT_0x, the fi eld to 
populate = Network_Streets.STAT_0x, and the value to use is RO_0x.STATION_NO. Populate 
the arrival time fi elds using the formula: Header = TIME_0x, the fi eld to populate = Network_
Streets.TIME_0x, and the value to use is RO_0x.Total_Minu. Be sure to remove the join each 
time.

Now, calculate the delay time between arrival of the fi rst and second responders. A fi re engine 
typically includes three or four fi refi ghters. To safely conduct rescue and initial interior operations, 
more fi refi ghters are often needed. Subtracting the First Due arrival time from the Second Due time 
will produce the approximate time interval between when the fi rst on-scene crew arrives and a 
second crew arrives. Right-click on TIME_02_01 and choose Field Calculator. Enter the formula 
[TIME_02] – [TIME_01] in the formula window and click OK. Inspect this calculation and save again.

Now it is time to make some maps. The Redlands folder in the sample dataset contains a Bonus 
folder with several Layer fi les for symbolizing the various responders (First Due, Second Due, etc.). 
Load all these Layer fi les and create a Group Layer for them named Run Order Group. Place the 
group just below Fire Stations in the TOC. Collapse the legends for Second, Third, Fourth, and Fifth 
Due.

Notice that data links to all Run Order layers are missing. To fi x this, right-click on First Due in the 
TOC and choose Data > Repair Data Source. Navigate to \GDBFiles\CASP835F\Redlands_Fire
.gdb and select Network_Streets inside the Run_Order_Streets feature dataset. Fix all layers in 
the Run Order Group in a similar manner. Turn off all Run Order layers except First Due. Switch 
to Layout View and study the colors. These First Due polylines seem to cluster around their home 
stations.

Calculating Delay 
Time

Mapping Run 
Orders—The Bonus 

Round
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To verify First Due relationships, click Add Data and navigate to \Bonus_Files\SHPFiles\CASP835F 
and load Optimized Travel Area.lyr. Place it at the top of the Run Order Group. This response area 
optimization was built from the same Redlands Streets using the functionality in Network Analyst to 
optimize service areas. Notice the alignment of First Due Streets and optimized response area 
boundaries, providing visual confi rmation of the First Due run orders. 

Turn off First Due and turn on Second Due. Look closely at the home area for Redlands Station 261 
and observe how Station 264 arrives second from the west, 263 comes in from the north, 262 fi lls in 
from the south, and Mentone 9 just reaches the eastern response area for Station 261 as Second 
Due. Check the Third, Fourth, and Fifth Due layers. 

Finally, let’s map the arrival time difference between First and Second Due. Turn off all Due layers 
and make the Second Due minus First Due layer visible. Study the color relationships. Green 
lines represent short time intervals and red lines represent long intervals. Notice the large time 
differences for each station are in closest proximity to that station. 

Study the attributes to understand that the green lines in fringe areas are not entirely good. Even 
though the arrival difference is small, the First Due times often exceed fi ve minutes. Look inside the 
City of Redlands. The time difference throughout much of the populated city is small, except in the 
most southern areas near Station 262 where all supporting responders must come from the north. 

As a bonus exercise, create thematic legends for all layers in the Run Order Group and design a 
separate map for each. Load these maps into Microsoft PowerPoint to create an informative slide 
show.

Run orders provide emergency responders with an accurate, reliable way to model complex 
responses with travel from multiple locations. This workfl ow counts on response from fi xed facilities 
with all responders who are dispatched simultaneously. This method works well for a static, 
districtwide model that includes automatic and mutual aid. As mobile dispatching and automated 
vehicle locators (AVL) become widely deployed, this workfl ow will need to be simplifi ed to speed up 
individual event dispatching.

In more complex scenarios, appropriate lag times are applied to manually requested resources and 
volunteer responders to refl ect additional time necessary for their departures. Also, unavailable 
units may be removed from the response stack. Apparatus types and personnel counts may also 
be included. As a word of caution in rural areas: when modeling long stretches of country roads, be 
sure to break street segments into appropriately short intervals.

Verifying 
Relationships

Run Order 
Benefi ts and 

Limitations
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Thanks to Chief Jeff Frazier and his staff at the Redlands Fire Department for providing fi re station 
apparatus and personnel information and the staff of the City of Redlands GIS for the use of their 
excellent data. Special thanks to Tom Patterson and Russ Johnson at ESRI for helping make this 
exercise a reality. 

Take the ESRI instructor-led course Working with ArcGIS Network Analyst.

(Reprinted from the Fall 2009 issue of ArcUser magazine)
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